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1: Using Solo Tech Notes [mw] 

Keywords:  tech support, fax, phone, searching

Written By:  Peter Harrison Date:  3/10/93 Last Updated:  03/12/2000

Solo Tech Notes include tips and advice on a wide variety of topics related to Solo. The information is from
both Axon and Solo users. If you have a question regarding Solo or a suggestion for a Tech Note, please
contact us:

Tech Support

Phone (203) 357-9701

Fax (203) 324-5085

E-Mail support@axoninc.com

Main Office

Phone (203) 357-9701

Fax (203) 324-5085

E-Mail sales@axoninc.com
info@axoninc.com

Searching The Tech Notes

Keywords are included in the Message Boxes for each Tech Note. To quickly find information pertaining to a
topic use these steps:

• Choose the Find command
• Enter a simple keyword, such as "powerpc"
• Click the Find button
• The appropriate Tech Note will be selected - in this case the one describing Solo PowerPC

Page 1 of 1
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2: Storyboard Printing Tips [mw] 

Keywords: overheads, print options, page setup, message boxes, leads

Written By:  Peter Harrison Date:  9/15/92 Last Updated:  9/15/92

The Print Options and Page Setup commands can be used to control the printing of Storyboards and text that
appear in each page's Message Box. This Tech Note will be of interest if you are interested in:

• Viewing or editing the full content of the Message Box text on paper
• Printing the Message Box text for transfer to cardboard borders of overhead transparencies

To view or edit Message Box text on paper…

Since Solo images text using PostScript, as many as 30 miniatures can be entered in the cells per page field
while maintaining the readability of the Message Box text. In the Print Options dialog box, select the Show
all text and Suppress empty checkboxes and deselect all other checkboxes. The content and flow of the
Message Boxes can then be studied on paper.

To print Message Box text for transfer to overheads…

In the Page Setup dialog box, change the Scale field to 400% and the orientation icon to Horizontal. In the
Print Options dialog box, enter 6 in the cells per page field and select the Show all text and Suppress
empty checkboxes and deselect all other checkboxes. The Message Boxes will be the appropriate size to
cut and tape to the cardboard borders of overheads.

The Print Options dialog box has
options for controlling printed
output, especially for
Storyboards.

The Page Setup dialog box has
options for scaling and
orienting printed output.

Page 1 of 1
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3: Creating Logo PICTs [mw] 

Keywords:  named objects 

Written By:  Peter Harrison Date:  9/21/92 Last Updated:  9/22/92

Solo's drawing tools allow you to create detailed illustrations, such as Logos. The illustration can be exported
as a PICT and then imported into a Picture Object. The object can be named and used on multiple pages.

In order to maximize the clarity of the illustration, draw it at an enlarged scale. This is needed because a PICT
representation does not have the same level of precision as a Solo drawing. For example, if creating a Logo to
replace the Logo Named Object in the Axon Template File, do the following:

• Create the illustration on an empty page
• The Logo object measures 1" x .5", so create your illustration 10" x 5" (10 times the desired size)
• Export the page as a PICT
• Command–Double–Click on the Logo Named Object
• Select the PICT you just created and click Import
• You will probably want to Modify All instances of the Named Object when prompted
• With the object selected, set the 100% checkbox in the Object Info dialog
• Using the Scale command, scale the Named Object to 10%
• Reposition the object if necessary

The resulting clarity should be excellent.

Named Objects are especially useful when incorporating images in your documents. In addition to the normal
benefits of Named Objects, another important aspect is in memory savings. A named image takes up only 1x
the memory size of the image, even if it is placed multiple times.

Page 1 of 1
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4: SAM Conflict [m]

Keywords:  incompatibilities, inits, extensions,  control panels, software 

Written By:  Peter Harrison Date:  2/26/93 Last Updated:  6/2/93

Symantec's SAM is a popular anti-virus software Extension. There are two issues to be aware of when using
SAM.

Because Solo saves to both the data and resource fork of its files, users need to instruct SAM to allow Solo to
save to the resource fork by clicking the Remember button in the SAM Alert dialog box. Be sure that the SAM
Intercept Control Panel Alert Preferences have been set with the Display Remember button option On. The
Alert will now longer be posted once SAM has remembered the Exception.

SAM slows launching of most applications because it scans the resource fork for viruses. In a quick test, we
found the following startup times on a Mac IIx of some typical products. Times are measured in seconds
required to open the application and a new document:

Product/Version SAM Off SAM On

Solo 1.2 10 20

Aldus Persuasion 2.1 15 25

Claris MacDraw Pro 1.5 20 30

Microsoft Word 5.1 16 20

Microsoft Excel 4.0 13 15 

Page 1 of 1
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If you use a 13" monitor at 100% scale, you cannot view an entire 11.0" x 8.5" page on-screen. The largest
area that can be displayed at 100% is 8.75" (width) x 6.5" (height).

Selecting Proper Font Sizes

When you decide to enlarge or reduce the scale factor, keep in mind that the text on the page is also scaled.
The scale factor will affect the font sizes that should be used. Remember, the Macintosh uses installed screen
fonts to image text on the screen. Unusual fonts sizes are scaled by the operating system as best it can with
sometimes sub-optimal results. The best results are achieved by using font sizes and scaling factors that work
well together.

The original font sizes you select should be based on the closest match to an installed screen font in the
resulting scaled image. Using the table below, if the scale factor is 120% as in image area "C", you may
choose to use only 10, 14 and 18 point text. These sizes, when scaled, closely match the standard 12, 18 and
24 point screen fonts and will produce the most legible results on-screen.

Font Sizes (in points)
Image Area Scale Factor (%) 9 10 12 14 18 24

A 100 9.00 10.00 12.00 14.00 18.00 24.00
B 110 9.90 11.00 13.20 15.40 19.80 26.40
C 120 10.80 12.00 14.40 16.80 21.60 28.80
D 130 11.70 13.00 15.60 18.20 23.40 31.20
E 140 12.60 14.00 16.80 19.60 25.20 33.60
F 150 13.50 15.00 18.00 21.00 27.00 36.00

5: Slideshow Design Tips [mw]

Keywords: presentation, monitor, design, image area, font sizes, hard copy reports 

Written By:  Mitch Rerek Date:  4/2/92 Last Updated:  3/10/93

Image Area

If you are creating overheads or giving a Slideshow presentation and there is no intention to distribute a paper
document, there is only one significant design constraint – the size of the image area.

When designing your format, keep in mind the image area that will be visible on the monitor. The image area
is influenced by the scale factor for the page and the page contents relative to the page center. Keeping in mind
that the center of the page is the scaling reference point, a series of concentric rectangles are drawn around the
page’s center point. By changing the page’s scale factor, we can determine the maximum image area that can
be displayed. 

A

B

C

8.5" X 11.0" page

D

Image Scale Factor % Maximum Image Area

A 100 8.75 X 6.500
B 110 8.00 X 6.000
C 120 7.25 X 5.500
D 130 6.75 X 5.000
E (not illustrated) 140 6.00 X 4.625
F (not illustrated) 150 5.75 X 4.375
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Clearly, using a scale factor of 100% offers the best of both worlds, the largest image area and 100% font size
display. Using a larger or smaller scale factor requires some important layout design work along with selecting
a proper font set to achieve the best results on-screen. 

A Simple Example

Let’s assume that a "New Product" presentation will be given to 4 members of your department. You are using
13" monitor and the global page scale factor is 100%. 
A 13" monitor at 100% scale will not display an entire 11.0" x 8.5" page on screen. The largest area that can
be displayed at 100% is 8.75" (width) x 6.5" (height). Given this information, we design our document format
to use an image area that is 8.0" wide and  6.0" high. This allows us to work at 100% scale and avoid font
scaling problems. Our font set consists of 14 and 18 point text which will be legible for the small audience

Hard copy Reports

If you are giving a Slideshow Presentation and you need to distribute hard copy reports to an audience, the
design issues become a little more complex. Your primary design goal should be to produce a clear,
consistent, and attractive paper report. The secondary goal is to produce a legible and visually attractive, on-
screen Slideshow while compromising the printed report as little as possible.

Using the earlier example, assume that we have to prepare a more detailed "New Product" presentation and
provide a hard copy report for the audience. For the presentation, we will use a video projection device that
projects the monitor screen onto a screen. The challenge is to design a document that will work well both in
hard copy and on-screen.

To accommodate the added detail in the written report, we will need to decrease the point size of the text from
18 to 14 and 14 to 9. This however, will be too small for the on-screen Slideshow. If we consult the scaling
tables, we see that using a scale factor of 130% allows us to use 9 and 14 point text and provide scaled 12 and
18 point text on the screen. However, the image area is reduced to 6.75" x 5.00". This compromise yields
acceptable results for accommodating both formats and avoids the additional work required to produce two
separate documents.

Page 2 of 2
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6: Slideshow Presentation Considerations [mw] 

Keywords: computer-based, audience 

Written By:  Peter Harrison Date:  3/10/93 Last Updated:  06/20/97

With Solo's Slideshow, you can use the computer to deliver your presentation. While there are a number of
benefits which result from a Slideshow presentation, it may not always be the right answer. Before using a
computer as the presentation medium, ask yourself the following questions:

• Is a computer-based Slideshow effective for my message or is it overkill in this situation? – If your
presentation would be more effective if delivered in traditional means, then don't force the issue of a
Slideshow.

• Will my audience be receptive to a computer-based Slideshow? – Even with the acceptance of
computers today, many people are uncomfortable viewing a computer presentation. Be sensitive to the
background and acceptance level of your audience as their attitudes will directly affect the success of
your presentation. 

• Will a computer-based Slideshow be effective given the environment? – Standard computer monitors
are too small to effectively use with more than a half-dozen people. Using a larger-screen projection
device isn’t difficult, but does require experience. Practice using the equipment as far in advance as
possible.

If you have any doubts, you may decide to stick to a traditional overhead or 35mm slide presentation. See the
Solo User Manual for instructions regarding producing overheads and 35mm slides.

Page 1 of 1
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7: Automated Slideshow Tips [mw] 

Keywords:  on opening 

Written By:  Peter Harrison Date:  3/10/93 Last Updated:  06/20/97

Solo's Slideshow has an On Opening mode that runs the Slideshow automatically. Live presentations can be
delivered in this mode, but it is typically not a good method when accompanied by an oral presentation:

• Keeping-up with or slowing down for the presentation is frustrating to both you and the audience
• Audience interruption or participation is not possible.

There are some instances when a stand-alone, self-running presentation is a good idea:

• Simple presentations for product overviews or advertisements
• Simple how-to procedures.

Automatic Slideshow Content

In the majority of automatic Slideshows, the author is not available to deliver the oral presentation or answer
questions. Therefore, creating an automatic Slideshow places an additional burden to ensure that the
information is presented clearly. Remember, be sure each page explains a key point clearly and that one point
flows logically to the next. Consider the following points: 

• Image Size
The image size depends on the size of the monitor used. If you intend to distribute the Slideshow to a
large audience, design it around a small monitor. Remember to include either scaling or monitor
specification instructions.

• Color
Not all computers  support color and colors do not map well to monochrome monitors. While
designing a color Slideshow, periodically switch to black & white and check the Slideshow.

• Content
In an automatic Slideshow, you have a certain luxury of time. Remember to present each point clearly
but balance the level of content with the attention-span of your audience.

• Looping
Based on the presentation environment, automatic looping may be or may not be appropriate. For
example, in a trade show presentation looping may be appropriate. In an instructional presentation, it
may not. 

• Timing
Measure the time it takes to read each page and add a comfort factor (e.g., 10%). You may want to
use the Until Click option in the Slide Settings dialog box to advance complex pages. If so, remember
to provide on-screen instructions.

Page 1 of 1
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8: RapidTrak Conflict [m] 

Keywords:  incompatibilities, inits, extensions, control panels, software

Written By:  Peter Harrison Date:  2/26/93 Last Updated:  6/2/93

Insignia Solutions RapidTrak is a utility for managing hard and removable disks and it has a performance
option called RapidMath which conflicts with Solo.

RapidMath changes math functions which Solo relies on to function properly and with RapidMath turned On,
Solo will crash randomly.

Turning RapidMath Off in the RapidTrak Control Panel will correct the problem.

Page 1 of 1
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9: PowerCache Conflict [m] 

Keywords:  incompatibilities, inits, extensions,  control panels, software, hardware

Written By:  Peter Harrison Date:  2/26/93 Last Updated:  6/2/93

DayStar's Universal PowerCache is an accelerator board and Control Panel file for improving (speeding up)
the performance of your Macintosh.

However, using the PowerMath component of the accelerator may cause problems with number processing.
Incorrect display of thousands separators in Solo has been confirmed on the Mac IIx.

The PowerMath option should be turned Off in the PowerCentral Control Panel when using Solo.

Page 1 of 1
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10: ClickChange Conflict [m] 

Keywords:  incompatibilities, inits, extensions,  control panels, software

Written By:  Peter Harrison Date:  2/26/93 Last Updated:  6/2/93

Dubl-Click's ClickChange is a utility for changing the appearance of components of the Macintosh System
interface.

Because Solo's color palette is not completely compatible with ClickChange's palette, not all colors will be
displayed properly in Solo.

You may want to disable ClickChange when working with Solo.

Page 1 of 1
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11: Solo Memory Usage on the Macintosh [m] 

Keywords:  large files, complex pages, on-screen, offscreen, partition, buffers, charts, picts, rotated text

Written By:  Peter Harrison Date:  6/2/93 Last Updated:  06/20/97

This Tech Note describes situations when you may need to increase Solo's memory partition to avoid running
out of memory on the Macintosh. Please keep in mind that memory usage is very dynamic and hard and fast
rules and limits do not apply all the time. Therefore, what follows are helpful suggestions.

Solo Memory Partition

Solo is shipped with a 2500 K memory partition. After startup, approximately 1500 K of memory is available
for creating and editing documents. This is sufficient memory for typical use.

• Memory partitions control the amount of RAM which applications can use to load and process source
code and document data. Free MultiFinder memory can also be used by applications. Solo, like many
other applications, is designed following Apple Computer's guidelines to take full advantage of
available free MultiFinder memory. 

• By utilizing MultiFinder memory, Solo is able to perform certain operations faster and more efficiently
than when restricted to it's internal 2500 K memory partition. 

• The amount of available MultiFinder memory depends on the amount of RAM installed in the computer
and the memory used by other applications running simultaneously with Solo.  

• If your Mac has less than 5 MB of RAM, there is probably very little free MultiFinder memory
available while running the System and Solo. If you have more RAM, Solo will be able to access
MultiFinder memory when it is available. However, to guarantee a larger amount of memory, you need
to increase Solo's memory partition (by using the Get Info dialog in the Finder).

• Very large Solo documents do NOT require significantly more memory to open and edit than smaller
ones. This is because pages are read into memory as needed. Memory requirements are instead based on
the size and complexity of individual pages. The more complex the page, the more memory it will
require. 

Complex Charts

Complex pages require additional memory to edit and print; notably pages with hundreds of Text objects.

• Charts with plot point labels turned On can quickly increase the number of Text objects on a page. As a
rule of thumb, based on the most complex page in a document, if there are less than 250 data points,
then the 2500 K memory partition should be sufficient.
For more complex pages, increase the partition by 500 K for each additional 250 data points.

• The same suggestions apply to pages with similarly large number of regular text objects.

Page 1 of 2



Solo™ Tech Note

Copyright © 1992-2001 Axon Inc., 21 Walmsley Road, CT 06820 USA

Printing PICTs and Rotated Text Objects

When printing PICT files imported into Picture objects OR Text objects which have been rotated, memory
requirements increase significantly.

• In order to maximize resolution when printing, Solo scales pages 4 times (4x) when printing to a 300
DPI
(dots per inch) printer and 8x when printing to a 600 DPI printer. For example, if a page contains a full-
sized PICT file which is 50 K, then printing it will require an additional 200 K for a 300 DPI printer and
400 K for a 600 DPI printer.

• As a rule of thumb, multiply the size of the largest PICT by the scaling factor of the printer resolution
and add that to the current memory partition. For example, if the largest PICT in the document is 100 K
and you are printing to a 600 DPI printer (8x), then you should change the memory partition to 3300 K
(2500+800).

Offscreen Drawing Feature

Solo's has an offscreen drawing feature. This means that when a document window is updated or redrawn, it is
drawn offscreen and then copied all at once back to the screen. This improves performance and makes screen
feedback cleaner and crisper; avoiding slow and unattractive screen redrawing.

• Offscreen drawing requires a memory buffer which depends on monitor size and color depth (2, 8, 24,
32 bit). If sufficient memory is not available in the MultiFinder or in Solo's memory partition, Solo will
revert to on-screen drawing. 

• In order for offscreen drawing to be utilized, you may have to increase Solo's memory partition,
especially if you are working in color on larger monitors.

• Here are suggested memory partition settings (in K) in order for offscreen drawing to function under
normal use. The suggestions are based on the monitor size, color settings and assume that no extra
MultiFinder memory is available.

Monitor Size 1 Bit (B&W) 8 Bit Color 32 Bit Color
9" 2500 2500 3000
13" 2500 2500 3500 <-- Use these settings for PowerBooks
14" 2500 2500 3500
16" 2500 3000 4500
19" 2500 3000 5500
21" 2500 3000 6500

• Please keep in mind that Solo will work properly with a 2500 K memory partition regardless the size of
the monitor or color setting. However, it cannot utilize the offscreen drawing feature without sufficient
memory.

Page 2 of 2
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12: Creating Segmented & Subtotaled Build Charts [mw]

Keywords:  waterfall, source of change, waterfall, build up, build down, subdivided

Written By:  Mitch Rerek Date:  5/15/93 Last Updated:  8/10/93

Build charts illustrate the added or reduced
contributions of components to a total. 

Build Up charts are often referred to as Source of
Change charts, and Build Down charts as
Waterfall charts.

When using these charts there are times which you
may want to segment or subtotal individual items
along the baseline within the chart (see sample
chart to the right). 

While Solo's default templates are not pre-
formatted to segment individual items, you can
arrange the data and set the display options to
create segmented and subtotaled build charts.  

Let's begin by examining the sample chart. 

• Items 1 & 4 are single data items. 
• Items 2 & 5 are segmented items, each composed of 2 stacked data points.  
• Item 3 is a subtotal of the previous items (1 & 2). 
• Item 6 is a Total of all items in the chart. 

This chart presents 3 distinct problems:

1 We must “stack” multiple data points within single items along the baseline (items 2 and 5).
To solve this problem, we use the Baseline Axis's formatting options to “stack” multiple data series. This
is how items are segmented in any stacked chart variation (eg, Column-Stack). When we stack multiple
data points within a chart, we will introduce the remaining 2 problems. 

2 Because the standard Build type chart variation is not formatted to accommodate multiple data series, we
must modify the chart's drawing options so it is drawn correctly. To solve this problem, we will modify
the Build chart “Plot Options” dialog to change the display of the chart when it is plotted using multiple
data series. 

3 Because we will be entering multiple data series (to stack the items), we will modify the chart's data
window to accommodate the data and employ some simple mathematics to control the display of the
chart. 

10

5

5

20

5

15

10

50

Item 1 Item 2 Item 3
Subtotal

Item 4 Item 5 Item 6
TOTAL

Subtotal

Segmented Items
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The remainder of this Tech Note explains how to create segmented/subtotaled build chart step-by-step.  

1 Create a “Build” type chart (any variation) but do not enter any data (close the Data Window). 

2 Double-click the blank baseline axis to display the “Baseline Settings” dialog box. 
(You can also select the baseline axis and press Command-I to display the dialog box). 

3 At the bottom-left of the dialog box change the “Series” field to -100% (see illustration at right).
This forces multiple data series to “stack” on top of each other in the chart. We can then input multiple
data points for individual data items. 

4 Click the “OK” button to confirm the change and close
 the dialog box.  

5 Double-click the Plot Area in the chart to display the 
“Build Up/Down Options” dialog box.
You can also select the Plot Area and press Command-I 
to display the dialog box. 

6 Turn the “Total” and “Connect” checkboxes OFF.

Because we will be plotting multiple data points, this 
will suppress the display of multiple “Totals” and 
connecting lines and make the chart visually clearer.   
If these options were left On, we would have difficulty
 distinguishing between the different data series within
 the chart. In addition, the chart will draw incorrectly
 once we have input the data. 

7 Click the “OK” button to confirm the change and close
 the dialog box. 

In steps 1 - 7 above we have taken care of problems 1 & 2. 

Now let's turn our attention to the implications these
modified display options will have on data entry. 

The Data Window for the chart has thus far remained
unchanged. It contains a single data series column to plot
the chart. However, we know that we will be entering
multiple data points for certain items (eg, items 2 & 5 in the
sample chart). Thus we will have to change the Data
Window to use more than one data column in the Plot Area. 

In addition, because we have set the Baseline axis to stack
multiple data points we will use an alternative data entry
convention. In order to stack the items we need to segment,
we must enter the data along the same item row in the Data
Window but in different (adjacent) data columns. 

Page 2 of 5
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Note Item 6. Since we have turned OFF automatic total calculation for the chart,  we need to manually create
the total column ourselves (if it is required in the chart). 

From the table above it appears that we need at least 8 data columns in the data window. 

Next we need to open the Data Window and add additional data columns within the Plot Area. 

1 Open the Data Window for the chart. Either
Command-Double-Click on the chart frame or
select it and press Command-4 to open the
Data Window.  

2 Position the pointer over a data column TO
THE RIGHT of the first data column in the
window. Press and hold the Shift key and drag
the column to the left to add it to the current
Plot Area. Repeat this until you have added 7
data columns to the Plot Area. 

3 Enter the data as it appears in the table above
and close the Data Window. 

You should notice that the chart has correctly
plotted the segmented items (2 &5) but items 3 & 6
(subtotal & total) are incorrectly plotted (see
illustration at right). 

In Solo, Build charts plot successive data points in
relationship to the previous data point NOT the
baseline. Thus item 3 (subtotal) and item 6 (total)
will appear as illustrated. 

Keeping in mind the way that Build charts plot
successive baseline items, we can change the data to 
plot correctly. 

10
5
5

20

5

15

10

50

Item 1 Item 2 Item 3
Subtotal

Item 4 Item 5 Item 6
TOTAL

Segmented/Subtotal Data Entry Conventions

Below, the data for the chart is arranged in a table to illustrate how it will be entered in the Data Window to
stack items 2 & 5. 

 1 2 3 4 5 6 7 8

 Item 1 10        

 Item 2  5 5      

 Item 3 Subtotal    20     

 Item 4     5    

 Item 5      15 10  

 Item 6 TOTAL        50

Build Charts always plot
successive data points in
relationship to the previous
data point. 

In this case, successive
items are plotted “on top of”
the previous data point. 

Page 3 of 5
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Let's examine the Data Window illustrated below. 

By entering negative values in certain cells, we can force multiple data points to draw subtotal entries
correctly. 

In the “Item 3 Subtotal” row we have entered -20 to force the chart to draw a column back down to the
baseline. Since we require the next baseline item to plot from the top of the previous item, we need to enter a +
20 to bring the column back to the true “subtotal” value. 

By entering data in this manner, we compensate for the Build chart's plotting of successive baseline items.
Entering exactly the same negative and positive values forces the data shapes to exactly overlap each other.
This gives the appearance that the “subtotal” is drawn correctly. 

In addition, the last item in the chart, “Item 6 Total” also needs to be entered as a negative value to force it to
draw back down to the baseline. This completes the desired graphic look of the chart. 

After making these changes in the Data Window and closing it, the chart should appear as illustrated below. 

You should notice that for “Item 3 Subtotal” there are 2 plot point labels. 

• Select the topmost label for item 3 and
delete it. This leaves only the “-20” plot
point label. 

• Select the “-20” label and choose the
"Number Format…” command from the
“Chart” menu. 

• Click the “None” option in the
“Negative” section of the dialog box.
This will remove the negative sign
display from the plot point label. 

• Repeat this step for the “-50” plot point
label in the last item in the chart. 

This completes the process. 

(Your completed chart should appear much
like the one on the first page of this Tech
Note). 

A summary of the complete process appears on the next page. 
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Delete any “extra” plot point
labels and use the “Number
Formats” dialog box to remove
any labels that contain an
“improper” negative display
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Summary - Creating Segmented & Subtotaled Build Charts

• Create a Build chart. It can be either a Build Up or Build Down type.
• Close the chart's Data Window.
• Double-click on the chart's baseline and set the “Space Between Series” field to -100%.
• Click the “OK” button to confirm the change and close the dialog box.
• Double-click the chart's Plot Area to display it's Plot Options dialog box.
• Turn the “Total” and “Connect” checkboxes OFF.

Examine your data to determine the number of data columns needed in the Data Window Plot Area. 
Hint:  You will need enough data columns for each segment in the chart (including single item
entries), plus 1 additional column for each subtotal entry. 

• Open the Data Window and add the data columns to the Plot Area by Shift-clicking and dragging on the
Column header.

• Enter your data, remembering to keep all rows and columns clear of each other except for any
segmented items required.

Plotting Subtotals:
You should use the opposite sign for the
first value depending upon the direction the
chart is plotted (i.e., Up or Down).
- If you are plotting a Build Up chart, first

enter a negative value, then a positive
value.

- If you are plotting a Build Down chart,
first enter a positive value, then a
negative value.

Plotting Totals:
Since you have to create a Total column manually, remember to use the opposite sign from the
direction the chart is plotted. 
- If you are plotting a Build Up chart, enter a negative value for the Total.
- If you are plotting a Build Down chart, enter a positive value for the Total.

• Close the Data Window to plot the chart.
• Delete any unnecessary plot point labels and use the Number Format dialog box to remove negative

signs from the appropriate plot point labels.

August 10, 1993 Update

In Solo 2.0, 4 new chart variations have been added that support the creation of subdivided/subtotaled Build
type charts. They are:  Build Up-Bar.seg/sub, Build Up-Col.seg/sub;  Build Down-Bar.seg/sub, Build Down-
Col.seg/sub

These new variations have been pre-formatted to support the use of multiple data series (stacked) as
explained in this Tech Note. You should review the discussion of the data entry conventions these charts
employ to properly enter data for these charts. 
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13: Creating Line Charts With Different Patterns [mw]

Keywords:  line pattern, actual, projected, forecasts

Written By:  Mitch Rerek Date:  6/15/93 Last Updated:  6/16/93

Distinguishing Current Vs. Projected Data

Line charts are often used to illustrate forecasted data. A
common technique to visually distinguish current vs.
forecasted data is the use of different line patterns (or colors). 

Solo's Line charts draw lines using data driven polygons.
Since polygons can only use a single pen pattern (or color) it
is not immediately obvious how to solve this “graphic”
problem.  

A simple and easy solution is to take advantage of the way
Line charts plot data. 

Line charts plot data using the following two rules:

1 Lines are drawn from the first active data point to the
last active data point in the data window.

This means that lines can be plotted in the middle of a
data series by leaving empty data cells at the beginning
or end of the series (or both). 

2 If gaps are encountered in a data series (eg, NA values
or empty data cells), line charts interpolate the data
across the missing points (i.e., lines are drawn across
empty data cells). 

Rule 1 means that we can enter data so that two series can be
connected to make them appear as one. Thus by entering data
in a specific way, you can create the chart illustrated above. 

In this sample we use two data series and leave selected
portions of each series blank. The chart will draw lines for
only those cells that contain data. To insure that the two lines
align properly we will “overlap” a single data point. 

In addition, Solo automatically assigns different line patterns
for different data series. Coincidentally, this is exactly what is
required for this charting situation. 

This “data gap” technique can be used for as many data series
as required for the chart. 
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Notice that 3 data series have been used to draw a single line. 

• The 1st series plots the line from 1980-82 
• The 2nd series plots the line from 1982-86 
• The 3rd series plots the line from 1986-88 

After plotting the chart, select the 3rd series line and change its pen pattern (color) to match the first. This
achieves the desired look required for the chart. 

Alternatives…  

In the sample chart above, we used three data series for a very specific reason. When line charts are drawn,
successive data series are drawn behind preceding data series. By using three data series that “overlap” by a
single data point, we eliminate potential layering problems. 

Plotting the chart as illustrated in Sample A would result in the second series becoming “lost” behind the first. 

Alternatively, keeping in mind that successive series are plotted behind preceding series, if we arrange the data
as illustrated in Sample B we achieve the desired results. 

Distinguishing Selected Portions Of A Line

Certain charting situations call for distinguishing interior portions of line charts. Here too, you can apply the
“data gap” technique. 

In the sample chart below, we are required to visually distinguish years 1982-1986. By entering the data using
the “data gap” technique we can create this chart. Let's examine the chart's Data Window (see illustration
below).

Author's Note…

Thanks to Fiona Potter for her contributions to this Tech Note. 
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14: Creating 35mm Slides With The Autographix Driver [m]

Keywords:  aspect ratio, 35, 35mm, slides

Written By:  Mitch Rerek Date:  6/30/93 Last Updated:  06/20/97

The Autographix printer driver (AGX 4.0) can be used to create 35mm slides in Solo for the Macintosh.

Axon does not have a formal agreement with Autographix to distribute the driver with Solo. The driver is
distributed with various software packages and is used specifically to create 35mm slides for imaging on
Autographix equipment. It creates individual PICT files from pages in a Solo document. 

Autographix  PICT files can be delivered to your local imaging vendor via diskette or modem. To have the
files properly configured for imaging, you will need the ToAGX-MAC application which accompanies the
driver. The use of the ToAGX-MAC application is explained in the Autographix documentation which you
should consult for detailed instructions. 

Setting Up A 35mm Document

1 Place the Autographix driver in your Extensions folder.
If you are running System 6, place the file inside your System Folder and reboot your machine. 

2 Select the Chooser desk accessory from the Apple menu. 

3 Click on the Autographix driver. 

4 Close the Chooser window. 

5 Launch Solo and enter the first page in an “untitled” document. 
– Press Command-2 for Shrink-To-Fit view. You should notice that the page is not a standard page.

It's dimensions are set to match the 2:3 aspect ratio necessary for 35mm slides.

6 Select the Page Setup command from the File menu. 
– You will see the following dialog box: 

– Solo recognizes the driver and adjusts the pages accordingly. This dialog confirms that Solo is using
the Autographix driver. 

7 Create all of the pages for your presentation.
– You may want to create a new Layout template in the document so you can quickly create the pages

for your presentation. 

After completing all of the pages, you need to create the AGX PICT files for imaging. 
– In the Finder, create a folder to contain the files that will eventually become slides. Later when you

run the ToAGX-MAC application to prepare the files for imaging, it will be easier to select all the
files when they are in a single folder. 
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“Printing” The Slides

1 Enter the first page in the 35mm document. 
– Since the AGX driver creates individual PICT files, you have to print the pages individually from

the Page Editor. 

2 Choose the “Print” command from 
the “File” menu. This displays the 
dialog box illustrated at right.

Click the OK button.

3 A standard “Save As…” dialog is displayed 
allowing you to name and save the file. 
Store it in the folder you created in step 7 above. 

4 After naming and saving the file, 
Solo will output the file. 

5 You will see the following warning dialog box:
Click  the “Continue” button. 

This dialog box is posted because Solo uses PostScript for drawing many of its objects. In our tests, we were
able to ignore this dialog for pages containing objects originally created in Solo. Pages which have had EPS
(embedded postscript) files placed on them may not image properly.

6 After the warning is dismissed the following dialog is displayed to confirm that the slide has been
created.

To create all your slides, Print each page in the document from the Page Editor and follow steps 1 - 7 above.  

After you have created all of the slide files, you need to use the ToAGX-MAC application to prepare them for
imaging by your local vendor. Consult the Autographix documentation for the necessary steps. 
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Keywords:  license, copy protection

Written By:  Peter Harrison Date:  7/26/93 Last Updated:  7/27/93

Axon distributes Solo directly to customers in many different countries. Since it does not have local
representation in each of these markets, Axon needs some form of copy protection to help prevent unlicensed
use of Solo.

A review of traditional methods of copy protection (e.g., network awareness, key disks) found them either
ineffective or too cumbersome. Axon's objective is to enforce Solo license agreements without burdening
legitimate users with an annoying copy protection scheme.

The approach selected combines a built-in expiration date with display of the licensee information during Solo
startup. The expiration date controls the period for which Solo is usable and display of the licensee
information makes it clear who is licensed to use the copy.

What are the benefits of the expiration date approach?

• The approach is transparent to legitimate users.
• It limits the licensee's exposure for copies which are illegally distributed outside their organization by

controlling the time that the copies are usable.
• It can be helpful in managing user updates. Keeping users up-to-date with current versions of software

is difficult in many large organizations. Axon will work with organizations to tailor the expiration date
to their needs.

How does the expiration date approach work?

• Purchased copies of Solo are set to expire after 12 months. The licensee information (organization
name, location and number of copies purchased) is also recorded in Solo. As of Solo 2.0, a Solo Key
will contain all expiration date and licensee information. Extending the expiration date will involve
simply distributing a new key.

• For the 15 days prior to the expiration date, messages warning that Solo will expire will be displayed on
startup. For each day after the expiration date, the number of messages displayed will be incremented
by one. This will gradually slow startup but will never disable Solo.

• The expiration date uses the date and time from the Mac System clock. Therefore, it is important to
properly set the clock before installing and while running Solo. Attempting to avoid the expiration date
will disable Solo. This can only happen by setting the clock to a date after the expiration date, starting
Solo, and then setting the clock to a date before the expiration date.

• It is possible to completely drain power to a Mac and force the System clock to reset (most commonly
with a PowerBook). If this does happen, the date may revert to 1904. However, if Solo has not yet
expired, the expiration date approach will still work properly.

• The current expiration date can be checked within Solo by selecting the About Solo entry in the Apple
menu. The expiration date is also stamped on the back of the master Solo diskette.
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16: Empower Conflict [m]
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Written By:  Peter Harrison Date:  8/31/93 Last Updated:  9/2/93

Empower 4.0.8 is a utility developed by Magna for Macintosh security. It consists of a Control Panel for
setting security options and an application for releasing volumes under its control.

When Empower is installed, Solo will crash if Solo is already running and you Double-click on a Solo
document in the Finder to open it. It will also happen if you choose the Open menu command from the File
menu in the Finder. It will not happen if the document is on the Desktop. This crash occurs because Empower
patches an Apple System routine with its own code. When this patched routine is accessed by Solo,
unexpected values are returned and Solo crashes.  

Magna has fixed the problem in Empower 4.1 which is scheduled for release before the end of 1993. Until
then, the only way to avoid the crash is to de-install Empower (press the Option key when starting the
Installer) or only open Solo documents from within Solo. Therefore, we have made a change to Solo which
avoids the problem that Empower 4.0.8 sets up and enables you to use both Solo and Empower. This change is
in Solo 1.2.8n.

Many thanks to Frank Tsouros in New York for identifying this conflict.
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17: A4 Vs US Letter Page Setup [mw]

Keywords:  default, auto conversion

There is a problem when working on documents in different countries with most other software. Since A4
Letter is used in most of Europe and US Letter is used in the US, converting between the two paper sizes can
be difficult and time-consuming.

Solo solves this problem by automatically converting between the two paper sizes. The Solo paper size default
is based on the default of the current printer driver in the System Folder. The printer driver is selected in the
Chooser dialog box. If the printer driver is part of the US system, the default paper size in Solo will be US
Letter. If the printer driver is part of a non-US system, the default paper size in Solo will be A4 Letter. 

Solo also converts the page content from the center of each page not the upper-left corner as done in some
other programs. This means that if you keep page content away from the edges of the page, it will not be
clipped when printed on either paper size.

The paper size can be temporarily changed by selecting the Page Setup command from the File menu in the
Page Editor. However, whenever you switch pages or switch to the Storyboard and back, the default paper size
will be read from the current printer driver in the System Folder.

If the default paper size is not what you want, you need to use a different printer driver. It can be obtained
from Apple or most online services. This may also be an indication that you are using a System configured for
another country. If this is the case, it will also impact the default measurement system (inches vs. centimeters)
and default currency format ($) used by Solo.
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18: Version 1.2.8 and 2.0 Document Compatibility [m]
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Written By:  Peter Harrison Date:  11/1/93 Last Updated:  11/1/93

We have worked hard at making Solo version 2.0 and 1.2.8 documents both forward and backward
compatible. This means that you can use 2.0 to open and edit 1.2.8 documents and vise versa. This is true as
long as you DO NOT USE THE NEW 2.0 TOOLS TO CREATE OBJECTS in a 1.2.8 document.

Once you have created a multigon, star, bracket or table (or imported a QuickTime Movie), the document
becomes a 2.0 ONLY document. You will not be able to open it with 1.2.8, even if you delete the new object
from the document! Also, Template Files which are 2.0 ONLY documents cannot be used by Solo 1.2.8. 

We have added a shortcut option in version 1.2.8p which will allow you to open a 2.0 ONLY document. To do
this, press the Shift and Control keys while opening or importing the 2.0 ONLY document. Pages containing
any of the new 2.0 objects (tables, multigons, stars, brackets or movies) will not be able to be accessible.
When attempting to enter the Page Editor or print any of these pages, you will see a dialog stating that the
page cannot be processed.

This shortcut is designed for emergencies only. If you frequently share documents between 1.2.8 and 2.0
users, you should upgrade all users to the latest 2.0 version.

Page 1 of 1



Copyright © 1992-2001 Axon Inc., 21 Walmsley Road, CT 06820 USA

Solo™ Tech Notes

19: Setting Solo Preferences [mw]
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Written By:  Peter Harrison Date:  11/12/93 Last Updated:  06/20/97

Solo 2.0 provides substantial control over user preferences. Our approach has been to use existing dialog
boxes for setting preferences. There are two types of preferences:

• Session Preferences
– Session preferences only remain in effect until you quit Solo.
– They are set by first deselecting all objects, opening the appropriate dialog box and clicking the OK

button.
• User Preferences

– User preferences are permanent.
– They are set by pressing the Option (Alt) key while clicking the OK button in the appropriate dialog

box.

User preference information is recorded in the Solo Prefs file which is located in the Preferences folder in your
System Folder. If deleted, Solo will replace the Solo Prefs file upon startup. You will then have to redefine
your preferences.

Preferences can also be built into a Template File. Therefore, if you are using a customized Template File, you
may not have control over some preferences. For information regarding building preferences into a Template
File, see Tech Note #20.

Consult the table on the next page for a complete list of Solo preferences and how they can be set.
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View Dialog Box Settings Menu Command To set, press

Check Spelling Main and User dictionaries Edit/Check Spelling… Nothing

Preferences (application) All Edit/Preferences… OK

Slideshow-Preferences All View/Slideshow/Preferences… Option (Alt)-OK

Place Template Format pop-up Templates/Place Template… Nothing

Page Numbers All Storyboard/Page Numbers… Option (Alt)-OK

Character All Text/Character… Option (Alt)-OK

Paragraph All Text/Paragraph… Option (Alt)-OK

Tab All Text/Tab… Option (Alt)-OK

Text Ruler All Text/Text Ruler… Option (Alt)-OK

Table Object Info All Objects/Object Info Dialogs Option (Alt)-OK

Dimensions All Table/Dimension… Option (Alt)-OK

Borders All Table/Borders… Option (Alt)-OK

Cells All Table/Cells… Option (Alt)-OK

Text Styles All Table/Text Styles… Option (Alt)-OK

Number Format All Chart/Number Format… Option (Alt)-OK

Preferences All Chart/Preferences… Option (Alt)-OK

Drop Shadows All Objects/Drop Shadows… Option (Alt)-OK

Rounded Corners All Objects/Rounded Corners… Option (Alt)-OK

Arrowheads All Objects/Arrowheads… Option (Alt)-OK

Power tool Object Infos Unique Power tool settings Objects/Object Info Dialogs Option (Alt)-OK

Rulers All Layout/Rulers… Option (Alt)-OK

Page Editor

Storyboard

Storyboard or Page Editor

Setting User Preferences 
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Written By:  Peter Harrison Date:  11/17/93 Last Updated:  5/10/2000

For information on setting Solo preferences, see Tech Note #19.

(Obsolete - See new Tech Note #36) 

User preferences are recorded in the Solo Prefs file which is located in the Preferences folder in your System
Folder. The information is recorded in resources which are stored in the resource fork of the file. Using a
utility called ResEdit, you can copy and paste preference resources from the Solo Prefs file to a Template File
Source document. Most preferences built into a Template File will override user-defined preferences. 

Editing resources in Solo files should only be done by those with experience and an understanding of the
implications. Doing so haphazardly is risky. Please contact Axon if you need help.

Building preferences into a Template File is useful because it helps promotes consistency among users in large
organizations. For example, if the chart preference resource is built into a Template File, then every user will
create charts with the same default attributes. However, be careful. You wouldn't want to build in preferences
which restrict users, such as application preferences.

All preference resources built into a Template File will override those in the Solo Prefs file, with the exception
of the Page Editor drawing preferences (DPRF). Solo will override the Character, Paragraph, Text Ruler, Tab,
Drop Shadow, Rounded Corner and Arrowhead preferences. The Rulers and Power Tool settings specified in
the Solo Prefs files will be honored.

Given this information, the best approach for implementing a Template File with built-in preferences is as
follows:

• Delete the Solo Prefs file from the Preferences folder in your System Folder.
• If you are using a Template File change it's name to something other than "Template File" so it will not

load into memory when Solo starts-up. 
• Start Solo 2.0. This will create a new Solo Prefs file.
• Go through the table in Tech Note #19 and set your preferences. Changes will be recorded to the Solo

Prefs file.
• When you are finished, quit Solo.
• Start ResEdit and open the Solo Prefs file and a copy of your Template File Source document. 
• Consult the table on the next page. 
• Copy the resources from the Solo Prefs file and paste them in the Template File Source document.
• When done, save the changes and quit. Your Template File Source document now has built in

preferences.
• Use the Template File Source document to make the final read-only Template File. 

There is one other aspect to Solo preferences. Default chart settings are controlled with scripts built into Solo.
These specify the chart defaults other than those set in the Chart Preferences dialog box. An example of this is
the position of pie chart labels.

If provided with the necessary information, Axon can customize these scripts. The resources containing these
scripts can then by copied and pasted into the resource fork of a Template File. Just like Solo will honor some
preferences built into a Template File, it will also use built in scripts to control the format of default charts.
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Resource Type Description Copy to Template File?

AXPB Storyboard Page Numbering Settings Yes

AXPS Slideshow Preferences Yes

DPRF Page Editor Drawing Settings Yes

PREF Chart Preferences Yes

TTS1 Table Object Info and Dimension Settings Yes

TTS2 Table Border Settings Yes

TTS3 Table Cell Settings Yes

TTS4 Table Text Style Settings Yes

TTS5 Table Row/Column Settings Yes

APRF Application Preferences Never copy

AX01 File Version Never copy

itl0-1 System international number formatting Never copy

NFMT Number Format Settings Never copy

SPL2 Spelling Dictionary Settings Never copy

Solo Preference Resources

The table below lists the preference resources which exist in the Solo Prefs file and a description of each. The
last column indicates which resources should and should not be pasted into a Template File's resource fork.
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Written By:  Peter Harrison Date:  1/25/94 Last Updated:  06/20/97

Customers who use the Axon Template File to create their reports, have expressed interest in making minor
changes to the templates. For example, how to change the font from Palatino to Helvetica. This Tech Note
describes how to make basic changes like this. It is not a replacement for Chapter 10 of the user manual which
describes in detail how to modify and create Template Files.

Editing A Template File

• Close the currently open Template File by choosing the Close Template File command in the Templates
menu.

• Open the Axon Template File by pressing the Option (Alt) key and choosing the Open command in the
File menu.

• Locate the Template File. Normally, it is in your Solo folder.
• When it is opened, you can tell it is a Template File by the display of [TEMPLATE] in the title bar of

the window.
• Save changes by using the Save command in the File menu.
• The modified Template File will be reopened in the background when Solo is started if the file is named

Template File and stored in the Solo folder. 

Modifying Named Paragraphs

You may want to modify the names or formatting of the Named Paragraphs built into the Template File.

• To view the current Named Paragraphs, choose the Apply Paragraph command from the Text menu.
You can rename, delete and reassign command keys in this dialog.

• To change the font or formatting of a Named Paragraph, insert a Named Paragraph, delete it from the
dialog, modify the font or formatting and then name it.

Modifying Named Objects

Named Objects are used to build most Templates, especially Text and Layout templates. You can tell objects
which are named because they have hollow (not black) selection handles. 

• To view the current Named Objects, choose the Place Named Object command from the Templates
menu. You can rename, delete and change property links for any Named Object in this dialog.

• To modify a Named Object, place it and then change it.
• Click the Modify All button if the Alert is displayed. This will change all copies of the Named Object

which may be used in other Templates.
• After modifying the Named Object, select it and choose the Name Selected Object command in the

Templates menu. This will update the master copy of the Named Object. 
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Modifying Templates

Any template can be modified like a normal Solo page. Chart templates are built into Solo and cannot be
modified.

• Go to an empty page and place the Template, remembering the Name.
• If you are modifying a Concept illustration, don't place a Layout. This is done by setting the Layout pop

up to None.
• Modify the page as necessary and Select All objects.
• Choose the Make Selection Into Template command from the Templates menu.
• Enter the name of the Template. The Replace button will be highlighted once the Name is entered.

Click OK.
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Written By:  Mitch Rerek Date:  5/3/94 Last Updated:  8/15/94

Beginning with version 2.0.4, Solo is installed using the Axon Installer application which greatly simplifies
and automates both first time installations and updates. When updating, it selectively replaces Solo files
leaving all user documents untouched. It can be run from diskettes, a hard disk or across a network. It can also
update copies of Solo stored on locked volumes.

Using the Installer

The Installer can be launched by double-clicking the 
Installer document icon (e.g., Install Solo 2.0.4) or 
the Installer icon. 

The Installer can perform two separate functions:

1 A First Time Installation 

2 An update of an earlier version of Solo

• After clicking the OK button in the greeting dialog, the Installer scans all mounted volumes for copies
of the files it is about to install. 
– If it finds a match, it will automatically perform an Update of that copy. 

This will cause an older version of a file to be replaced by a newer version. If the Installer finds
more than one copy of a file, it will display a dialog box containing a list of the files allowing you to
select which one to update.

– If after scanning your hard disk the Installer does not find any matches, it will request that you
select a volume on which to perform a First Time Installation. This will copy the software on the
installation disks to the selected volume.

• The installation can be interrupted at any time by clicking the Stop button in the progress dialog or
pressing Command-Period.

• To force a First Time Installation, press the Option key when clicking OK in the greeting dialog.
• If you want to run the installer from a hard disk, copy all of the Installer files to a single folder. It is

essential that all of the files are in the same folder for the Installer to work correctly. This folder can
also be shared across a network. 

First Time Installation

During a First Time Installation, all files in the archive are installed. 
If the files have not been placed in a folder prior to compression, the installer will create a folder using the
name of the first file in the archive. For example, if the first file in the archive is "Solo 2.0.4", all of the file
in the archive will be installed in a folder named "Solo 2.0.4 Folder".  
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Updates

During an Update, the Solo application and Template File will be replaced with newer versions by the
Installer. Newer versions of Main dictionaries will also replace older versions.  All other files in the
archive are NOT installed when updating an earlier version of Solo. However, the archive can be
customized to change this behavior.  

Customizing the Installer Archive

The Installer uses a Compact Pro archive to install its files. Large Solo sites will be interested to know that the
installation process can be modified to include custom files such as Template Files. This is done by modifying
the Compact Pro archive used by the Installer.

Axon can provide a shareware version of Compact Pro which includes instructions for purchasing and
becoming a registered user. Alternatively, you can purchase a copy by sending $25 to:

Cyclos Software
P.O. Box 31417
San Francisco, CA  94131-0417  USA

Customizing the installation is done by modifying the Compact Pro archive. 

Archive Requirements

• First Time Installations & Updates
If the archive is to be used for First Time Installations it MUST contain at least the following three files:
– The Solo application, a Template File and a Spelling Dictionary

Additional files can be added as required. If the archive is missing the minimum three files listed above,
the Axon Installer will NOT install the archive. NOTE: When the archive contains the required three
files it can also Update a user's hard disk. 

• Updates ONLY
If the archive is only for distributing an Update (e.g., a new version of Solo, Template File or
Dictionary) it can contain only those files that should be updated on the user's hard disk. 

• NOTE: If you are using a customized Template File and plan to distribute a new version of that file you
are required to modify the file's version resource information in order for it to be correctly installed.
Contact Axon for additional information before creating your customized archive. 
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Forcing File Installations

You can force the installation of specific files during an Update by placing a plus sign (+) in front of the
file (or folder) name before adding it to the archive. The Installer recognizes file and folder names starting
with a plus sign and will always install them during an update. 
For example, naming the "Read Me" file "+Read Me" ensures that it will always be installed during an
update. 

Adding/Replacing Custom Files to the archive 

To add or delete files from the archive, open it using the Compact Pro application. 
– Files are added to the archive using the "Add…" command from the "Archive" menu. 
– Files are deleted from the archive using the "Clear" command from the "Edit" menu. 

Additional Information

After building (or modifying) the archive, compress it using the Compact Pro default names. It can either
be a self-extracting archive ".sea" or a compressed archive ".cpt". The ".cpt" files are slightly smaller in
size.

Segmenting The Archive For Diskette Distribution
If you plan to distribute the Installer using diskettes you may have to segment
the archive. Segmenting breaks the archive file into smaller individual pieces
that will fit on a diskette. 

- To segment the archive, open the archive and choose the "Segment"
command from the "Misc" menu. Select the appropriate segment size
and segment the archive using the Compact Pro default names. 

- If you segment the archive, it is essential to place the LAST segment of
the archive on the FIRST disk with the Installer application and install
document. 
This is necessary because the last archive segment contains the
information about the other archive segments. 
Place the other segments on separate diskettes (if necessary). 

Installer Document

The Axon Installer ships with a small Installer document. It is used to start the Installer and is useful for
instructing users. The name of the Installer document appears in the Installer's greeting dialog when it is
used to start the Installer. You can rename the Installer document (Install Solo 2.0.4) if necessary.

The files required for installation are: 

• Axon Installer document
• Axon Installer application
• Compact Pro archive (segmented or not).
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Written By: Peter Harrison Date:  6/8/94 Last Updated:  6/17/94

It is becoming increasingly difficult to gather and maintain all of the latest information for properly
configuring a Macintosh. The order in which the various components (System Software, System Enablers,
Hardware System Updater, Network Software Updater, CD ROM Software, Printer Drivers, Extensions,
Control Panels and Applications) are installed has become a critically important factor.  

If you are having problems with Solo or other applications (such as random unreproducible crashes or bugs), it
may be due to a problem with the System software. Solo expects that certain portions of the System Software
have been properly installed. The following guidelines should help you to properly install System Software.

Guidelines

1 Initialize the hard disk using the latest version of the Apple HD SC Setup application (or equivalent
software if using other formatting software).

– Before initializing, you should backup all data you wish to save, including documents and user-
defined files such as template files and user dictionaries.

– Installing 'over' an existing system (eg, System 7.0 to 7.1) is NOT recommended. 

2 Install the latest version of the System Software. 
– Use the original diskettes which came with your Mac. You cannot create one system which will

work on all Macs. This is especially true with the AV machines which have specialized hardware
features. 

3 Part of the System Software installation is a "System Enabler" specific to your Mac (if required). 
– You should verify after installation that the Enabler version in the System Folder is the latest

version available from Apple.

4 Install the latest version of the "Hardware System Updater" software.
– Apple regularly releases Mac specific updates which fix bugs in the System Software.

5 Install the latest version of the "Network Software Updater" (if applicable). 

6 Install the latest version of your "CD ROM Software" (if applicable).

7 Install the latest version of your "Printer Driver".
– Most printers work fine with Apple's standard LaserWriter driver. You may want to try using it

before running a printer-specific installer.

8 Once the System Software installation is complete, you should make a backup copy prior to installing
any other software. This enables you to easily reinstall just the System Software at a later time if
necessary.

9 Finally, install your Desk Accessories, Extensions, Control Panels and Applications using the original
diskettes. Make sure you have the latest versions of each and check that they don't install earlier versions
of any of the System software components you have just installed.
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10 Remember, before doing any installation, first restart the Mac with all Extensions off. This is done by
pressing the Shift key during startup.

– Running an Installer with Extensions on can damage other software. If possible, it is also best to
startup from a separate system on another hard disk and perform installations on your main system.
This is not necessary but is the safest approach.

Following these guidelines and keeping abreast of Apple's updates should help you maintain stable System
Software.
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Written By:  Peter Harrison Date:  6/16/94 Last Updated:  6/16/94

MacroMaker is a utility from Apple Computer for recording keystroke commands and saving them as macros.

We have had reports of miscellaneous problems using Solo with MacroMaker installed. To the best of our
knowledge, MacroMaker was developed by Apple but is no longer supported. 

If you wish to use a macro utility we suggest using a supported commercial product such as QuicKeys from
CE Software or Tempo from Affinity Microsystems Ltd. 
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25: LaserWriter 8.1.1 Bugs [m]
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Written By:  Peter Harrison Date:  8/25/94 Last Updated: 11/3/94

The LaserWriter 7.1.2 printer driver was recently replaced by the LaserWriter 8.1.1. Although the new driver
improves printing speed, some problems have been introduced in Solo and other programs. The LaserWriter
8.1.1 release notes from Apple list a number of these.

We recommend using the 7.1.2 driver with Solo. However some of Apple's new printers require the 8.1.1
driver (or a later version). If you do need to the use the 8.1.1 driver, be aware of the following known
problems:

LaserWriter 8.1.1 Problems

• Smoothed filled polygons (e.g., a fancy bracket) which follow a text object in the page's stacking order
get printed with no fill. Moving the polygon to the back of the page will fix this.

• A text object with a dashed pen and mixed text styles (e.g., first line bold and second line plain) will
crash.

• Rotated PICTs, objects with dashed line pens, and groups of smoothed polygons can cause random
crashes.

• Users have also reported random crashes using the Storyboard QuickPrint icon but this has not been
confirmed.

Please let us know if you encounter other problems so we can add them to this Tech Note.

A Beta copy of the new LaserWriter 8.2 driver appears to fix the first problem with the smoothed filled
polygons. As of this writing, the driver has not been released.
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Written By:  Mitch Rerek Date:  8/31/94 Last Updated:  8/31/94

Template File designers often need to add new templates to their Template File Source document. This can
sometimes be confusing, especially if you rely on a set of custom preferences built into your Template File
(see Tech Note #20).

When editing a Template File Source document, it is a common practice to close or rename the standard
Template File so it is NOT used by Solo during the editing session. This eliminates the confusion between
duplicate Named Paragraphs, Named Objects and Templates which will appear twice in their respective dialog
boxes; one set residing in the Source document and the other in the open Template File. 

When creating or modifying templates in a Source document without a Template File open, your user
preferences will be used and not those built into the Template File. This can create formatting problems if
there are differences between your user preferences and custom Template File preferences. For example, new
objects may not adhere to the specifications required for your organization's graphic format (eg, tables may
use different fonts, sizes or paragraph formats). 

Here's how to overcome the problem… 

Create a designer's Dummy Template File which DOES NOT contain any Named Paragraphs, Named Objects
or Templates (i.e., nothing at all) but DOES contain built-in custom preferences in it's resource fork. You can
then edit your Source document using the Dummy Template File to eliminate duplicates and insure that your
custom preferences are used when creating new objects.

Creating a Dummy Template File…

1 Create a new untitled document and choose the Make Template File… Command in the Templates
menu.

2 Name the new Template File “Dummy Template File” and Save it inside your Solo folder. Close the
untitled document and Quit Solo. 

– Since the Dummy Template File document is empty, it does not contain any Named Paragraphs,
Named Objects or Templates. There will be NO duplicate objects when editing a Source document. 

3 Run ResEdit and open the Dummy Template File and your original Template File (or Source Document)
that contains your custom preference resources. 

4 Copy all the preference resources from your Template File and Paste them into the resource fork of the
Dummy Template File. Then close the Template File (or Source document). 

NOTE: If you are using another resource editor (such as Resorcerer) DO NOT COPY the “<DF>”
resource.

5 Save the Dummy Template File and Quit ResEdit. 

6 Inside your Solo folder, change the name of your standard Template File to something like “Template
File Standard” and change the name of the Dummy Template File to “Template File”. 

You can now run Solo and edit your Source document without the redundancy problem and your custom
preferences are used when creating new objects. 
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Written By:  Mitch Rerek Date:  9/19/94 Last Updated:  9/19/94

There are times you may need to combine a line chart and a bar
or column chart to illustrate a comparison of one item's measure
against another (e.g., a company's monthly sales in comparison to
an industry average). The chart may look something like the one
on the right. 

There are a number of ways in which to create this simple chart.
You could overlap two fixed scale charts, a line and a column so
they appear as one chart when printed. However this is
cumbersome. 

There is an easier method for creating this chart that uses the
Overlay Line “Connect” feature. The procedure takes advantage
of the fact that when plotting multiple data series the “Connect”
overlay option only “connects” the first data series in a chart. 

Follow the steps below to create a line/column combination chart
in one chart frame. 

1 Create a “Column Butted” chart variation.

2 Enter the data points for the “average” line in the first data
column.

We enter the “average” data first because we will use the
Overlay “Connect” option to draw the line in the chart. 

3 Enter the data points for the bars/columns.
The data window  should look something like the
illustration at right. 

4 Close the data window to plot the chart 

5 When the chart is plotted it will look something like the
chart on the right. 

6 Select the first data series' plot point labels and press the
Delete key.

This will delete the labels for the first (line) data series.
This does not permanently delete the labels but is the
shortcut method for turning them Off.

7 Select the first data series in the chart (click once).

8 Use the Fill and Pen pop-up menus to format the columns to
have a fill and pen color of “none”. 

This makes the columns “disappear”. 

5.4

32.7 29.3 25.6

8.8 12.3

Jan Feb Mar Apr May Jun

1994 MONTHLY SALES REVENUE
$ Thousands

Industry
Average

14.3

29.5
24.3 21.7

5.5
9.5

5.4

32.7
29.3

25.6

8.8
12.3

Jan Feb Mar Apr May Jun

5.4

32.7
29.3

25.6

8.8
12.3

Jan Feb Mar Apr May Jun

Page 1 of 2



Solo™ Tech Note

Copyright © 1992-2001 Axon Inc., 21 Walmsley Road, CT 06820 USA

9 Select the chart and choose the “Add Overlay…” command from
the “Chart” menu. Turn the “Connect” checkbox On. Click the
OK button to close the dialog box. 

The overlay line will apply to the first data series in the chart.
The chart should appear something like the one below. 
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10 Double click the baseline in the chart to display the
"Baseline Settings” dialog box. 

11 Enter -100% in the “Space Between Series” edit
field and click the OK button to close the dialog
box. 

The data series in the chart will exactly overlap
each other. This shifts the connecting line over
slightly so it appears in the horizontal center of
the second series' columns. The chart should
appear something like the one below. 
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Turn
this
checkbox
ON

Set to -100% to force
the series in the chart
to overlap each other

Summary

We have created a line/column “combination” chart, which is completely data driven by taking advantage of
the fact that the “Connect” overlay line is plotted on the first data series in a chart that contains multiple data
series. 

Suggestion

You should make a Template out of this chart and incorporate it into your organization's Template File or in a
stationery document to save it for future use. 
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Written By:  Peter Harrison Date:  11/4/94 Last Updated:  11/4/94

We are often asked about Solo's compatibility with the PowerPC and our plans for a native PowerPC version
of Solo.

We are happy to report that Solo is fully compatible with Apple's new Power Macintosh computers! Solo 2.0.4
and all later versions run faster on the Power Macs than on any other Mac available.

To take further advantage of the speed of the Power Macs, Axon is working on a native version of Solo which
should be available in the second half of 1995.

To learn more about Power Mac compatibility, please read on…

Apple's new line of Power Macintosh computers utilize the high-performance PowerPC chip developed jointly
by Motorola, Apple and IBM. The Power Macs are an excellent choice for computer users for a number of
reasons: excellent price/performance, compatibility with existing Mac software, increased performance with
new native Mac software and the potential to run Windows software.

Software runs in two modes on a Power Mac - emulation and native. In emulation mode, the Power Mac
mimics the older 68K chip (the predecessor of the PowerPC) and enables you to run your existing Mac
software. In native mode, programs are able to directly access the speed of the PowerPC chip.

Performance in emulation mode will vary among programs. One reason is the degree to which a program
relies on the Mac Toolbox. Think of the Toolbox as software which is actually built-into your Mac. With the
Power Macs, much of the Toolbox has already been converted to native code. Therefore, the more a program
relies on the Mac Toolbox, the faster it will run on a Power Mac, even in emulation mode!

Fortunately, Solo takes full advantage of the optimized Toolbox which explains why it already runs faster on a
Power Mac than on any other Mac.
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Written By:  Mitch Rerek Date:  10/14/94 Last Updated:  11/7/94

There have been many recent requests for information on moving Solo PICT files to Intel based PCs. The
process is not difficult but requires a number of steps. One thing to keep in mind is that when Solo PICTs have
been moved to a DOS (Windows) based application the appearance of the translated file(s) will depend upon
the DOS application's ability to interpret the Macintosh PICT file format. Obviously, when the file is exported
from a Solo document the objects on the page(s) will no longer behave as they did in Solo. 

The procedure requires that you export PICT files from the Solo document, copy them to a DOS formatted
disk (or across a network) and Import them into a DOS application that is able to interpret Macintosh PICT
files. 

Our tests have been most successful when importing Solo PICTs into Corel Corporation's CorelDRAW
version 3.0 running under Windows 3.1.1 on a '486 machine. The steps below outline the procedure.  

Macintosh - Export Your Pages As Solo PICTs

1 Open the Solo document which contains the page(s) that are to be exported. 

2 In the Storyboard, select the pages you wish to export by Shift-clicking on them. Choose the “Export”
command from the “File” menu. This will create individual PICT files for the selected pages. 

NOTE:  If the page(s) contain objects on either the Guide or Background layers that should not be
exported to the PICT file, you should export the page(s) from the Page Editor. Before exporting the
page use either (or both) the “Hide Guide Layer” or “Hide Background” commands from the
“Layout” menu to hide those layers. When layers are “hidden” the contents of that layer are not
exported to the PICT file. 
Exported PICT files are automatically named by Solo using the document's name appended with
“.exp”, the page number “.12” and a “.PICT” extension (e.g., Hanson Report.exp.12.PICT). 
TIP:  If you are exporting multiple pages, you should create a folder to store the exported PICT files. 

3 Rename the exported Solo PICT files.
On the Macintosh files can have names of up to 31 characters in length. Under Windows (DOS) file
names cannot exceed 8 characters and only a 3 character file extension is supported (e.g., .PCT).
Since you will be moving the files over to a PC you should change the file names to observe these
limits.
TIP:  CorelDRAW recognizes “.PCT” file extension when importing Macintosh PICT files. Your
work will be much easier under Windows by renaming the files on the Mac to observe the 8 character
limit and then add a “.PCT” extension to the filename. 

4 Format a DOS diskette and copy the files to the diskette.
– This can be done using Apple Computer's PC Exchange software or one of the many third party

software packages that support the formatting of DOS diskettes on the Macintosh. 
– If you are connected to a network that supports multiple platforms, you can copy the files to a

server. 
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WINDOWS - Import the Mac Files Into CorelDraw

1 Copy the file(s) to the PCs hard disk. You can also leave them on the diskette if you like. 

2 Under Windows (or DOS) open CorelDraw 3.0.

3 Use the Import command in CorelDraw to import your file(s) onto the page. 
– This is done on a page-by-page basis for every file. 
– CorelDRAW will parse the files based upon their file extension and place the objects on the page. 

Remember that the files should have a “.PCT” extension in order for CorelDraw to correctly
interpret the Mac PICT files on the diskette (or directory). You can use Windows File Manager or
DOS to change the file's extension characters if you have not done so on the Macintosh. 

– You will need to change the Page Setup of the new CorelDraw files to match those of the original
page from the Macintosh PICT file (i.e., match vertical pages from Solo to vertical pages in
CorelDraw). 

4 It may be necessary to adjust the positioning of the objects on the page so they match the original
Macintosh output. 

Generally speaking, they may have to be moved down slightly on the page. In our tests the objects
only had to be moved approximately 1/2 inch down the page to exactly match the output from the
Macintosh. 

5 The fonts used in the original Macintosh file may not “map” appropriately in the Windows environment.
Select the text objects and format using them using a font of your choice. 

During our tests the original Macintosh Palatino font correctly mapped to a corresponding Windows
font. In our printing tests the resulting output was excellent. Your results may vary depending upon
the fonts used in the original file and the fonts installed on the PC you use. 

Author's Note:

Thanks to Gary Augerbright and Mike Everly of Bullet Proof Computer Solutions for their contributions to this
Tech Note. 
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Solo documents normally print (or fax) in a single print job. However, you can change the page setup in the
Page Editor view for any Solo page, making it possible, for example, to include vertical and horizontal pages
in the same document. When printing a document with multiple page setups (also called print records), it will
get split into multiple print jobs. This is because most printer drivers can't process multiple print records in the
same print job. (FYI: This problem should be addressed by Apple's new QuickDraw GX printing software.)

While this feature is helpful to many users, it can be annoying when faxing documents or printing to a shared
printer. Here's how multiple print jobs get created…

• Creating pages with different printing options within a document
– Different orientations (e.g., vertical vs. horizontal)
– Different scaling factors (e.g., 100% vs. 75%)
– Other Printing options supported by the printer driver

• Creating pages and switching between different drivers within a document
When creating new pages, Solo uses the driver currently selected in the Chooser to create the page
setup. Since different drivers can support different printing options, switching drivers can create Solo
pages with different page setups. 

• Importing/Exporting or Copying/Pasting of pages between documents

A common cause of multiple print jobs is the sharing of pages between people who have different printer
drivers. If you have compiled a document that includes pages from several people who have different drivers,
when it is printed it may create multiple print jobs. 

Avoiding Multiple Print Jobs...

One way to avoid the problem is to standardize on a specific printer driver. When standard pages are imported/
exported or copied/pasted from one document to another the print record will be the same. This avoids
multiple print jobs. Keep in mind that pages using a different orientation, scaling factor or some other print
option will create multiple print jobs. 

Faxing Pages...

Most fax software drivers have a shortcut for temporarily selecting the fax driver to send a fax and then
automatically switching back to your printer driver. In most cases, the fax shortcut is accessed by pressing the
Option key before pulling down the File menu and choosing Fax. Check your fax software for details. This
shortcut will avoid creating new Solo pages using the fax driver page setup. 

If your fax software doesn’t support a fax shortcut you can avoid multiple print jobs by following these steps.
Create (and edit) your document using your standard printer driver. Save your document and Quit Solo. Select
your fax driver in the Chooser. Reopen your document, fax your pages from the Storyboard and Quit Solo. Re-
select you printer driver in the Chooser and restart Solo to continue working. 
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This procedure should avoid multiple fax jobs. Keep in mind that you want to consistently create (and edit)
your pages with the same printer driver and avoid changing individual page setups. While the fax driver is
selected in the Chooser you should not to create new pages or edit existing ones. 

Update 11/7/94 - Solo 2.0.6

With the release of Solo 2.0.6 there is a method for correcting the multiple print job problem. 

In all pre-2.0.6 versions, in the Storyboard you could use Option-Page Setup to change the print record for all
empty pages. In version 2.0.6 you can now use the Option-Page Setup feature to change the Page Setup for
existing pages (i.e., pages with content) in a document. 

If you experience the multiple print job problem with a document you should select the pages in the
Storyboard, press and hold the Option key and select the Page Setup command from the File menu. When the
Page Setup dialog box is displayed make the appropriate changes and click the OK button. The following alert
box is displayed:

If you wish to make the change, click the OK button. 

All of the selected pages print records will be changed to match the specified settings. When the selected
pages are printed, they will print in one job. 

NOTE: If you Save the document after making such a change the page(s) print records are permanently
changed. 

To make the change temporary, Save the document before making the change and then after printing close the
document without saving the changes. When the document is reopened, the original print records will be
intact. 

An alternative is to use the Revert command after printing the selected pages (remember to Save just prior to
making the print record changes). 
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Cost curves illustrate the relationship between two items
(e.g., cost and capacity). 

When using cost curves there are times you may want to
segment items along the baseline (x axis) in the chart. For
example, chart on the right compares three companies'
aluminum production in three regions of the world. 

Solo's cost curves are designed to plot each baseline item
adjacent to the previous item. 

While Solo's default cost curve is not designed to segment
individual items, we'll use simple mathematics and modify
our data entry to achieve the visual effect we require. 

Three data sets are entered for each company. To visually
stack the segments, each segment's Y value is entered as
the cumulative sum of the segments below it. The bottom-
most segment is entered normally. 

We must also force the chart to overlap the segments by
entering an extra baseline item that is the inverse of the
cumulative sum of all X values. This forces the chart to
return to the origin and plot the remaining segments in front
of the others.

The cumulative Y values for each data set are calculated as
follows:

1st data point X value and Y value as the cumulative
sum of all 3 regions.

2nd data point X value and Y value as the cumulative
sum of the first 2 regions.  

3rd data point X value and first region's Y value.

After calculating the Y values the AIH company data is as follows:

Data Point (X,Y) values Y value calculation
1st   (topmost segment) 4, 10 10 = 3 + 4 + 3
2nd 4, 7 7 = 3 + 4
3rd  (bottom-most segment) 4, 3 n/a

Company Capacity Australia Africa N & S Amer

AIH 4 3 4 3

HTS 10 4 7 9

PCH 18 7 8 12

Cost Per Ton By Region ($)

Capacity (kilotons)

Cost $/ton

N & S Amer

Africa

Australia

Worldwide Aluminum Production
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Region AIH HTS PCH

N&S Amer 4,10 10, 20 18, 28

Africa 4, 7 10, 11 18, 16

Australia 4, 3 10, 4 18, 7

Company

After calculating the data sets we sort them by region. 
The table above illustrates the calculated and sorted data
sets.

The data set for the topmost segment is always entered
first. Then the remaining sets are entered until we finish
with the bottom-most which plots along the baseline.  

Enter the data as illustrated in the data window at top
right. 

After the first data set we enter (-32,0). The X value is the
sum of all X values in the chart. By entering it as a
negative value coupled with a zero Y value the chart will
draw the next segment from the chart origin (0,0). 

The next segment is then drawn in front of the preceding
segments and creates the stacked visual effect we want in
the chart. 

Only one set of item labels is entered for the first data set
in the chart. This prevents duplicate labels from appearing
in the chart. 

When first plotting the chart, it may look something like
the one at right. 

Making the chart look like the original example on the
previous page is a matter of using the chart's display
options and some standard formatting procedures.  

• The 2 point Step Lines have been turned off in the
charts Plot Options dialog box (bottom right).

• To shade the different segments, click one of the
segments. This selects all segments simultaneously.
Use the Fill pop-up at the bottom left corner of the
document window to assign a white fill color. 

• Next select the segments to be shaded identically
by Shift-clicking them. Use the Fill pop-up to
assign a fill color. 

In the example on the previous page the individual plot
point labels, axis titles, legend and chart title were created
and positioned manually. 

The chart's display options used in different combinations
will allow you to create a few variations based upon the
example illustrated here. 
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The (-32,0) data point forces the next data
point to plot back from the chart origin.

This stacks the following data points on top
of the preceding ones.

Turn the Step Line checkbox Off

31 Creating Stacked Cost Curves [mw] – continued
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32: Changing Solo’s Colors [m]

Keywords:  editing, palette, rgb

Written By:  Peter Harrison Date:  9/1/95 Last Updated:  9/5/95

Solo has a color palette which provides a range of colors
popular in business presentations. However, some users
have a need to create a precise color. While there is no
user interface for changing the color palette within Solo,
the palette can be changed as detailed in this tech note.

This requires knowing a few things…

• How to use a resource editor like ResEdit
• The color resource layout in Solo
• The RGB values for your colors.

Solo’s Color Palette Resource

• Using ResEdit, open the Solo application and
CPAT resource ID#5001

• Each color from the palette is identified by a
number; see the diagram to the right

• For each color (red #31 shown below), there are
RGB values and a pattern and an alternate black &
white value and pattern

Page 1 of 2

Color Palette

1 2 3 4 5 6 7 8 9 10 11

12 13 14 15 16 17 18 19 20 21 22

23 31 39 47 55 63 71 79 87 95 103

24 32 40 48 56 64 72 80 88 96 104

25 33 41 49 57 65 73 81 89 97 105

26 34 42 50 58 66 74 82 90 98 106

27 35 43 51 59 67 75 83 91 99 107

28 36 44 52 60 68 76 84 92 100 108

29 37 45 53 61 69 77 85 93 101 109

30 38 46 54 62 70 78 86 94 102 110

Black and White Patterns

C
olors

Color Palette Numbering

Color Palette Resource Values
(for red #31)
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RGB Values

• Colors are defined by a number of different models including RGB (red, green, blue), CMYK
(cyan, magenta, yellow, black) and HSL (hue, saturation, lightness). Solo uses the RGB model
with values between 0 and 65,535 for each color. 

• You need the RGB value for each colors you want to use in Solo. You can get these most easily
using Adobe PhotoShop. Note that RGB values in PhotoShop are based on 0 to 255 and will
need to be converted to values from 0 to 65,535. Contact Axon for assistance.

• RGB values are displayed in the Solo resource as hexadecimal values. You can convert your
decimal values to hexadecimals and enter them preceded by a $ or just enter the decimal
values. A utility like BaseTool is handy for hexadecimal conversion if necessary.

Changing Colors 

• Duplicate your copy of Solo as you will be permanently changing the application
• Find the existing color in Solo which most closely matches the color you would like to use. For

example, you may want to slightly modify the Red color. 
• Find the color number from the diagram on page 1, red is #31. Using ResEdit, find the color  in

the CPAT resource and enter the desired RGB values.
• The color pattern is typically left the same which is solid. Also, the black & white value and

pattern are also typically left the same as this is how the color will be displayed in black &
white. This values can be changed if necessary.

• Save changes and quit ResEdit when finished. Then start Solo to see (and use) the new color in
the palette.

• When implementing a suite of colors, we recommend starting at color 22 and working
backwards (such as using 18 through 22) because these colors are infrequently used black &
white patterns and will consolidate your colors in one section of the color palette.

Other 

• Changes need to be made to every copy of Solo or the changed application can be given to
other licensed users. Remember to document any color changes because they need to be made
whenever a new version of Solo is installed.

• New colors may not exactly correct on screen because the monitor is limited in the number of
colors it can display. However, the color will be printed and exported with the precise RGB
values.

32: Changing Solo’s Colors [m] - continued
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33: Creating Butted and Stacked Charts [mw]

Keywords:  column, bar

Written By:  Mitch Rerek Date:  9/15/95 Last Updated:  9/18/95

While the chart to the right may look like fairly simple,
it’s actually a little tricky to create. This tech note
explains how to create a column or bar chart with stacked
values which are in groups butted together.

• Create a Bar Butted chart.
• Turn the Stacked option on using the Chart-Options

dialog box.
• Use the Chart-Baseline Axis dialog box and change

the Space Between Items to 0%.
• Enter the data as illustrated in the Data Window.

The empty rows provide a space between the
groups of butted bars.

Options

• If appropriate, use the Chart-Plot Point Labels
dialog box to turn on the data labels in the middle
of the bars. Alternatively, you cam add a scale axis
to the chart using the Chart-Scale Axis dialog or by
choosing a Bar Butted.s chart to start.

• You may want to select the individual data shapes
and change the shading or colors. Use the Shift key
while clicking to select multiple data shapes at
once.

• You may also want to align each item label to the
center of the group of butted bars. This is done by
selecting the labels and moving them with the
mouse or the arrow keys.

Page 1 of 1
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With the cross platform release of Solo 3.0 many Solo users have requested information about converting their
customized Macintosh Template files over to the Windows platform. 

Under Windows, Template files actually use 2 files. The first, named "Template File.X1F" contains templates.
The second, named "Template File.X1F.RSR" contains custom preferences. 

The process requires using Solo 3.0 for the Macintosh to create two new files. Follow the steps below to
convert your Macintosh Template File to a Windows Template File.

1 Launch Solo 3.x.x on the Macintosh. 

2 Close the Template File by choosing the "Close Template File" command from the "Templates" menu. 

3 Press and hold the Option key while choosing the "Open" command from the "File" menu. 
– This permits the opening and editing of a Template File. 

4 Open the Template File stored inside of your Solo folder. 

5 After the Template File has opened, press and hold the Option key while choosing the "Make Template
File" command from the "Templates" menu. 

– The document's title bar should have the name of the Template File appended with "[Template]".
– In the save file dialog box, the name of the Template File will be appended with ".X1F.RSR". 

This is the file extension required for the resource portion of the Template File under Windows.
An .X1F.RSR file under Windows contains only custom preferences. 

6 Save the file “Template File.X1F.RSR” inside your Solo folder and then quit Solo. 

7 In the Finder, open your Solo folder and duplicate the standard Template File using the "Duplicate"
command from the Finder's "File" menu. 

8 Rename the new duplicate of the Template File to “Template File.X1F”. 
– The ".X1F" is the file name extension required for a Template File under Windows. 

9 Transfer the “Template File.X1F.RSR” and the “Template File.X1F” files to the Solo folder on a
Windows computer. 

– This can be done by copying the files over a network or by diskette if the files will fit on a diskette.
Using a network is the recommended method for transferring files. 

– Make sure to keep a backup copies of these files. We recommend that you backup or move the
original files on the Windows machine before replacing them with your newly converted files. 

10 Launch Solo and test to see that your custom Template File performs as it does on the Macintosh. 

If you have questions please contact Axon Tech Support at (203) 357-9701. 

34: Moving Custom Template Files From the Macintosh to Windows [mw]

Keywords:  template file, custom, resource, converting

Written By:  Mitch Rerek Date:  08/30/96 Last Updated:  08/30/96
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With the cross platform release of Solo 3.0 many Solo users have requested information about converting
customized Template files. These requests have focused on recording new preferences, changing exisiting
preferences and how they can be moved between the Macintosh and Windows platforms. 

The process requires copies of Solo and ResEdit on the Macintosh platform. You should be familiar with Solo
Tech Notes 19 & 20 before attempting to use the following information. 

Editing resources using ResEdit should only be done by those with experience and an understanding of the
implications. Doing so haphazardly is risky. Please contact Axon Tech Support if you need help.

To create new custom preferences for the Macintosh (and move them to Windows) you must use a ResEdited
version of Solo on a Macintosh. 

– Macintosh users will need to complete Sections 1 and 2. 
– Windows users will need to complete Sections 1, 2 and 3.  

Section 1 - Modifying Solo's PFSN Resource

1 Make sure that you have a copies of the Solo 3.x.x and ResEdit programs on the Macintosh. 

2 Launch ResEdit and open the copy of your Solo program file. 

3 Double-click the "PFSN" resource icon in the Solo program file window. 

4 Double-click the ID 128 entry ("Pref File Sequence Number") and change the "Don't write RF Prefs on
Set" entry from "True" to "False". 

– This change will insure that new preferences are properly recorded in the resource fork of the "Solo
Prefs 2" file when using the Option-OK method to specify preferences. 
The windows should appear as illustrated below.

35: Placing Custom Preferences into Solo 3.x.x Template Files [mw]

Keywords:  preferences, templates, template files, resedit, converting

Written By:  Mitch Rerek Date:  04/8/97 Last Updated:  04/8/97
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5 Quit ResEdit. When you are prompted to save your changes, click the "Yes" button. 
– This will insure that the "PSFN" resource changes will be saved to the Solo program file.

(Obsolete - See new Tech Note #36)
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Section 2 - Inserting Custom Preferences into Macintosh Template Files

1 Change the name of the Template File inside your Solo folder to something other than "Template File"
(e.g., "My_Template File").

– This insures your current Template File will not load into memory (RAM) when Solo starts up and
there will be no conflicts with its built-in preferences. 

2 Delete your "Solo Prefs 2" file.
– This file is stored inside the "Preferences Folder" inside of the "System Folder". 

3 Launch the ResEdited copy of Solo (this process is described in Section 1) and record your new
preferences by opening the appropriate dialog boxes and using the Option-OK method to record your
preferences to the new "Solo Prefs 2" file. When you have finished Quit Solo. 

4 Launch ResEdit and open the "Solo Prefs 2" file.
– A new file will have been created inside the "Preferences Folder" inside of the "System Folder". 

5 Inside ResEdit, open the Template File you renamed earlier ("My_Template File").

6 Copy the resource preferences from the new "Solo Prefs 2" file to the clipboard.
– You should read Solo Tech Note #20 to verify what resources should and should not be copied into

a Template File. 

7 Paste the new preferences into "My_Template File" and save your changes.
– ResEdit may prompt you to replace existing resources with the same ID. If this occurs, click the

"Yes" button in the dialog box then save the file. 

8 Close both files and quit ResEdit.

9 Delete your "Solo Prefs 2" file from the Preferences folder (it is stored inside of the System Folder).
– This insures that your user preferences (stored in the Solo Prefs 2 file) will not conflict with the new

preferences placed into the Template File. 

10 Inside the Solo folder, rename "My_Template File" to "Template File" and launch Solo. 

Check that all new preferences perform as expected.
– If the new preferences work correctly, you can distribute the new Template File to other Solo users.

If they do not work correctly repeat steps 2-9 of this section. 
– If the new preferences work correctly and you need to move the new Template File to the Windows

platform proceed to Section 3. 

Section 3 - Moving Template Files to the Windows Platform

Under Windows, Template Files actually use two files. The first, named "Template File.X1F" contains
templates. The second, named "Template File.X1F.RSR" contains custom preferences. 

Use the following steps to convert the Macintosh Template File into a Windows Template File. 

1 Launch Solo 3.x.x on the Macintosh. 

2 Close the Template File by choosing the "Close Template File" command from the "Templates" menu. 

3 Close the default "untitled" document. 

4 Press and hold the Option key while choosing the "Open" command from the "File" menu. 
– This permits the opening and editing of a Template File.

Page 2 of 3
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5 Open the Template File stored inside of your Solo folder.
– The document's title bar should have the name of the Template File appended with "[Template]".

6 After the Template File has opened, press and hold the Option key while choosing the "Make Template
File" command from the "Templates" menu. 

– In the save file dialog box, the name of the Template File will be appended with ".X1F.RSR". 
This is the file extension required for the resource portion of the Template File under Windows.
An .X1F.RSR file under Windows contains only custom preferences. 

7 Save the file “Template File.X1F.RSR” inside your Solo folder and then quit Solo. 

8 In the Finder, open your Solo folder and duplicate the standard Template File using the "Duplicate"
command from the Finder's "File" menu. 

9 Rename the new duplicate of the Template File to “Template File.X1F”. 
– The “.X1F” is the file name extension required for a Template File under Windows. 

10 Transfer the “Template File.X1F.RSR” and the “Template File.X1F” files to the Solo folder to a
Windows computer. Place them in the Solo folder. 

– This can be done by copying the files over a network or by diskette if the files will fit on a diskette.
Using a network is the recommended method for transferring files. 

– Make sure to keep a backup copies of these files. We recommend that you backup or move the
original files on the Windows machine before replacing them with your newly converted files. 

11 Launch Solo and test to see that your custom Template File performs as it does on the Macintosh. 

If you have questions please contact Axon Tech Support at (203) 357-9701. 

Page 3 of 3
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For information on setting Solo preferences, see Tech Note #19.

To support the creation of customized Template files a new "Preference Imbedding" feature has
been added to Solo 4.0. Preference imbedding means that preferences can be stored as part of a
document's data. If the document is turned into a Template File, its custom embedded
preferences are used when running Solo with the Template File.

Normally, preferences are permanently saved by pressing and holding the [Alt] ( [Option]) key
when clicking the OK button in a dialog box that supports recording preferences. This records
the preferences to the "Solo Prefs2" file. If Caps Lock is On, when attempting to save
preferences, Solo will now store the preferences into the front most, open document.

Ideally, custom preferences should be embedded in template SOURCE documents. This allows
a template file designer to maintain a consistent set of preferences across several generations of
a Template File. SOURCE documents are standard documents which contain the Named
Paragraphs, Named Objects and Templates that comprise a report format. SOURCE documents
should always be made into Template Files for distribution to end users.

Imbedding preferences in a SOURCE document that will become a Template File...

1 Launch Solo and close the "untitled" document.
2 Open the SOURCE document. (*)
3 Engage the [Caps Lock] key (i.e. make sure that Caps Lock is ON).
4 Visit each dialog which settings you want to include in your Template File, enter the

settings you want, press [Alt] and click OK to store the settings in the file.
5 Choose "Save" from the "File" menu.
6 Create an updated Template File from the Source document by choosing "Make Template

File..." from the "Templates" menu. Name the new file "Template File".
7 Exit the Solo application.
8 Rename the original Template File in the Solo directory "Template File_Axon" and copy

the new Template File from where you saved it into the Solo program folder.
9 Start Solo, the updated Template File will be opened and the imbedded preferences used.

*) If you do not have a Template File "Source" document, you can create a new Source
document from an existing Template File as follows:
- Launch Solo.
- Choose "Close Template File" from the "Templates" menu.
- Close the "untitled" document.
- Press and hold the [Alt] key and choose "Open" from the "File" menu
- Navigate to the Solo directory in your "Program Files" folder.
- Choose the file named "Template File" and click the "Open" button.
- Choose "Save As" from the "File" menu and name the new file:

"Template File [SOURCE]" and save it in the "My Documents" folder.

36: Imbedding Custom Preferences into Solo 4.x.x Template Files [mw]
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